10Tec DocMounter: What's New

-1-

2019-Nov-01

What's New in DocMounter
Keywords used to classify changes:
• [Added] – a new feature or functionality was implemented;
• [Changed] – a change in a functionality or interactive behavior;
• [Improved] – something is implemented better than in previous versions;
• [Removed] – a feature was removed.
• [Fixed] – a fixed bug or solved problem.

v2.2.8 | 2019-Nov-01
1. [Added] The editor for the Code tag in the Insert Tag dialog now contains a combo box to select the
language of the inserted code snippet. The selected language is inserted in the language attribute of the
code tag. The last selected language is remembered in the Insert Tag dialog.
2. [Changed] The Syntax section of member help topics does not contain the declaration for C++ in the
default configuration of DocMounter.
3. [Fixed] Links to overloaded versions of methods were missing in the HTML manual built with
DocMounter.
4. [Fixed] Minor problems with controls layout in the Insert Tag dialog were fixed.

v2.2.7 | 2015-Apr-01
1. [Added] The DocMounter Options dialog has two new ellipsis buttons that allow you to enter the
directory with the hxreg.exe and dexplore.exe tools easier using the Open File dialog.
2. [Improved] The style of all dialog windows was unified: they have the same icon and no longer visible in
the Windows taskbar.

v2.2.6 | 2013-Feb-14
1. [Added] The visual tag editor for inserting member reference tag was enhanced. Now it allows you to
specify a custom label for the inserted member and to generate a link to the special page of overloaded
versions of the member (if any) created automatically by the SandCastle compiler.
2. [Added] The tabs which display topic parts (Summary, Remarks, Example, …) has a new green bullet
indicator to indicate that the corresponding part isn’t empty:
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3. [Added] A DocMounter project has a new Boolean option to turn on/off writing summaries for topics
with subnodes into manual. It is set on the new Manual tab in the project properties dialog.
4. [Improved] The produced HxS file no longer contains almost unused JavaScript member declarations.
5. [Improved] The processing of the <code> tag was enhanced to remove possible appearance of
unneeded empty lines at the beginning and the end of the tag contents in the result files (HxS and
manual).
6. [Fixed] The parameters of a method that returns a value were sorted improperly in the project tree.

v2.2.0 | 2013-Jan-31
1. [Changed] This version of DocMounter no longer uses the algorithm that automatically inserts the
<para> tags into source topic texts as it may cause unpredictable formatting problems in the produced
help solutions viewed in different versions of MS Help Viewer. The <para> tags should be inserted
manually in the corresponding places while working on the project.
2. [Added] To help to enter the <para> tags for new topics and existing ones, the new “Wrap with <para>”
interface command was implemented (can be found on the main toolbar and in the Edit menu).
If this command is issued when no text is selected in the active text editor, the “<para></para>” string is
inserted, and the caret is placed between the “>” and “<” characters inside so you can enter the
paragraph text right away.
If you select some text before issuing this command, all paragraphs in the selected text (strings
separated by the CR/LF characters) will be wrapped with the <para> and </para> tags.
3. [Changed] The ampersand character in the source texts should be coded with the corresponding XML
entity code “&amp;”. The code tag editor does this replacement automatically.

v2.1.30 | 2013-Jan-30
1. [Added] The ability to reorder See Also items was implemented.
2. [Improved] More hints on what can be done in the interface are added next to some controls (available
keyboard combinations, etc). Some interface strings were changed for better understanding.
3. [Improved] A repeat click on an item in the Find Results list selects the corresponding node in the main
tree. This is useful if you clicked a found item to select the corresponding documented node, then
changed the current node to another one, and now want to re-select the previous node by clicking the
same selected item in the Find Result list.
4. [Improved] In this version, if a tree button in the project tree is clicked, the node next to it isn’t selected
automatically. This is useful if you need to expand some nodes to see their subnodes without changing
the current node.
5. [Improved] The style of section titles in manuals uses greater vertical margins for a better visual
separation.
6. [Improved] New words were added to the built-in spell checker dictionary.
7. [Improved] The visual editor for the <code> tag has a new hint. It tells that all special character entities
like “<” and “>” will be replaced with the corresponding equivalents automatically when inserting into
topic contents in the main window.
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8. [Removed] The rarely used <relatedTopics> tag is no longer used as the SandCastle compiler has some
problems when building topics with it.
9. [Fixed] If a method had 10 or more parameters, the project nodes which represent its parameters were
not sorted properly (general string sorting like “1, 11, 12, 2, 3” was used).
10. [Fixed] If we clicked the current node which represents a conceptual topic with the right mouse button,
selected the Properties command from the context menu and edited the properties, the unsaved
changed to the node details (summary, etc) got lost.
11. [Fixed] An ‘Access is denied’ error was raised when viewing documentation in MS Help Viewer 2.0
supplied with VS 2012.
12. [Fixed] The XML documentation files were created in the UTF-16 encoding which aren’t supported in
the recent versions of Visual Studio (tested in VS 2010 and 2012). Now the supported UTF-8 encoding is
used.
13. [Fixed] The XML documentation files didn’t contain the <?xml version="1.0" encoding="utf-8"?> prolog.
14. [Fixed] Code blocks were displayed with the first line shifted to the left.
15. [Fixed] The ‘Copy Code’ hyperlink in a result HxS copied the code without line breaks.
16. [Fixed] The produced HTML pages might miss needed paragraph tags.
17. [Fixed] Extra unneeded empty paragraphs were added to the result topic contents.
18. [Fixed] Section titles were placed as normal paragraphs without applying a special style in manuals.
19. [Fixed] CTRL+ENTER is used to add new lines in a project’s spell checker list, but the corresponding label
hint displayed ALT+ENTER.
20. [Fixed] The HxComp.exe (HxS file compiler) no longer generates the error 7096 (Name/Value of
<MSHelp:Attr> tag contains double quote) while producing the HxS help solution.

v2.0.14 | 2010-Nov-19
1. [Improved] Before you build or view an HxS file, DocMounter checks whether the required external
tools (such as HxReg.exe and MS Help compiler) can be found and displays the corresponding error
message if it cannot find them.
2. [Improved] If DocMounter cannot load a project because one of the documented DLLs cannot be found,
it displays a message box with the corresponding information and asks you to continue to load the
project without this DLL.
Thus now you can load a project even if some documented DLLs cannot be found. The types contained
in the absent DLLs will be displayed as obsolete in the project tree (sure they can become normal items
automatically when you load the project next time when the absent DLLs are found again).
In the previous builds of DocMounter the loading of the whole project in this situation was simply
cancelled.
3. [Fixed] DocMounter might crash when it automatically loaded the last project at startup and something
was wrong with the project.
4. [Fixed] The whole application might crash when unexpected exception occurred while initializing the
app. An additional error handler was added to prevent this (also displays the exception info).
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v2.0.12 (release of v2.0) | 2010-Oct-28
1. [Added] This major update of the tool uses the Sandcastle help compiler instead of the outdated and
unsupported NDoc used before. This allows us to build our HxS documentation in the latest available
Visual Studio style for this format (2005/2008) and use many new benefits provided by this compiler
including the .NET generics support.
2. [Added] This release of DocMounter solves many issues which are not possible in the standard MS XML
documentation. First, you can make links from member topics to conceptual topics and vice versa.
Second, you can use images both in conceptual topics and member topics.
3. [Added] The interface of the main window was rewritten. The main toolbar was simplified and new and
some old commands were sorted in the updated menu system. The menu and toolbar were
reimplemented using the more powerful .NET MenuStrip and ToolStrip controls.
4. [Added] The "Insert Tag" dialog was rewritten. The most significant changes are:
•

Now all tags are separated by categories for more convenience.

•

Tag names were changed for better understanding.

•

Editors for new tags (such as "Section" and "Bold Text") were added.

•

The editor of the "Image" tag was rewritten. Now it allows to select images from the sorted list
which is populated using the files from the Media folder of the project.

•

Many tag editors were redesigned for better visual perception (controls were rearranged,
explanatory labels were added, etc).

5. [Added] DocMounter has a new "Options" dialog available through the Tools\Options menu item. This
dialog allows you to specify general parameters of the tool (such as path to the hxreg.exe tool) used for
every projects.
6. [Added] A new DocMounter option "Auto Save Project Before Build" was implemented. It is set by
default which guarantees that your changes won't be lost even if something goes wrong or even
DocMounter crashes during the build process.
7. [Added] A new DocMounter option called "Delete Intermediate Files After Build" was implemented. If it
is set, DocMounter deletes all interim temporary files used to build the final result file (help solution,
manual, etc). Sometimes it is useful to analyze the contents of the files used to compile an HxS help
solution or another result, and if you clear this option which is set by default, you can do that.
8. [Added] All tree view controls used to select a member from the documented assemblies display only
the types from the project assemblies by default and have an option to display all other types from
referenced assemblies. This option is enabled through the check box named "Show Types From
Referenced Assemblies" next to the tree view controls. This default mode is very useful because in the
vast majority of cases we need to select members only from the documented assemblies, and all types
from other referenced assemblies (such as mscorlib.dll) just prevent us from finding the documented
members quickly.
This enhancement concerns the "Select Member" tag editor and two "Select Member" dialogs opened
when you add new "See Also" or "Exceptions" items.
9. [Added] When you create a new project, the "Open Assemblies" dialog is opened in which you can
select several assemblies to document. In the previous versions you could select just one assembly at
this step, and you needed to open the project properties, add the rest required assemblies there and
reload the project after that.
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10. [Added] DocMounter has a new dialog "Conceptual Topic Properties" opened by the corresponding
command from the Node menu or the context menu of the project tree. This dialog allows you to view
and change the Id and Title of the selected conceptual topic.
11. [Improved] The project properties dialog was redesigned. Now the similar project properties are
grouped into the tabs, and explanatory comments were placed next to some fields.
12. [Improved] The "Extra Members" pane was renamed to "Find Results", and now it uses the same lookand-feel like the Output pane (the same panel caption control, the same approach you can use to
open/hide it through the View menu).
13. [Fixed] The language filter at the top of the built topics isn't set to "All languages" each time when you
jump from one topic to another (due to the use of the latest available build of Sandcastle).

v1.5.0 (internal release) | 2009-Oct-29
1. [Added] Now DocMounter uses another text rendering control to edit the topic contents. It is the
Editor.NET text editor control produced by Quantum Whale (www.qwhale.net). The new editor gives us
the following benefits:
•

We can use syntax highlighting for the tags used in the topic sources.

•

We can implement spell checking a la MS Word in our topics directly in DocMounter.

•

The text in the editor window implements the unlimited undo/redo actions.

•

Such well-know control keys combinations as CTRL+A/CTRL+C/CTRL+V/CTRL+X are supported now.

•

We have the search and replace functionality now (through the CTRL+F/CTRL+H key combinations).

2. [Added] The built-in DocMounter spell checker uses two data files to check spelling.
First of them is SpellChecker.dat that contains a list of common English words. Generally this file is
enough to check spelling of a normal English text.
The other data file is optional and it is called SpellChecker_Custom.dat. In this file you can define a list
of words which are the proper words for a particular project you are working with (for instance, your
product names, specific terms, etc). You can have such a file for every project you work with, and
change them in the directory of DocMounter as you switch from one project to another.
Each file should contain one word per line, and it is not required that the lists should be sorted. Note
that the DocMounter spell checker is case-insensitive and all the words in these files should be written
in lower case.
3. [Added] The 'Load Descriptions from XML File' command in the Project menu was implemented. Like
the 'Load Descriptions from Attributes' command, it can be used to import the descriptions of the
members from the standard XML documentation files of the documented assemblies. This is very useful
if you have already documented your assemblies using the standard .NET documentation schema and
you'd like to document them further in DocMounter. In this case you just import the prepared
descriptions into the DocMounter project using this new command.
4. [Added] DocMounter saves and restores the position of its main form between launches.
5. [Added] The See Also section uses a new format of links to the members. First, the name of the class of
a member is added before the member to visually distinguish members of different classes. Second,
words as "Event", "Method", "Property", etc are added to the end to indicate the type of a member. For
instance, if you saw a see also link "BackColor" in the previous version, now you see something like
"MyClass.BackColor Property".
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6. [Added] When you press the Remove button below the list of See Also members or Exception list while
editing a member in the main window, a Yes/No dialog now pops up allowing you to confirm your
action.
7. [Added] When you add a new item to the See Also or Exception list for a member, now you can use
double-click to select the required item in the opened dialog and automatically close it.
8. [Improved] The Get Non-Described Members dialog was enhanced. Now the Summaries item is selected
by default, but your further personal settings are saved between its calls (even after program restart).
9. [Fixed] A bug with automatic insertion of a new paragraph if a tag like <b> was used inside a paragraph.
10. [Fixed] DocMounter might display useless HxComp warnings while compiling the help solution file.
11. [Fixed] If you clicked the ESC button in the start dialog (with the Load/New/Cancel buttons), the 'Load
project' action executed instead of cancelling the choice and closing the dialog.
12. [Fixed] The following bug of HTML rendering in the MS Document Explorer (in fact, in the Internet
Explorer rendering engine) was fixed: the HTML tag <p> in combinations with some other tags isn't
wrapped by the right edge of the browser window.
13. [Fixed] Empty rows in the code snippets in example sections might be absent in the result help pages.
14. [Fixed] The HTML links to enumeration members might be incorrect.

v1.1.1 | 2007-Mar-20
1. [Fixed] Now DocMounter supports screen resolutions different from the normal DPI (96).
2. [Fixed] When a library with nested delegates was documented, an error occurred.

v1.1.0 (release of v1.1) | 2007-Feb-16
1. [Added] DocMounter became a free tool distributed with full source code under the GNU General Public
License.
2. [Changed] Our iGrid.NET grid control was used in the previous versions of DocMounter as an interface
element in some dialogs. It was replaced with the standard .NET controls (such as DataGridView) in the
current version because DocMounter now is a free tool available with full source code. This version of
DocMounter requires only the .NET Framework 2.0 or higher to work and no longer depends on any
additional controls.

v1.01.2 | 2006-Nov-17
1. [Added] In the previous version when a reference was encountered more than once in a topic, it was
displayed just as a bold text, not as a reference (even in tables). Now you can specify that all the
references in the first column of a table should be displayed as hyperlinks regardless of whether they
were met before in the topic. This function is available for additional topics only and mainly used when
you create a table which lists members of a class in an additional topic, and you need to display the first
column with the members always as hyperlinks (if this flag isn't specified, the references may be
displayed just as bold text in the case they are listed before in the topic).
2. [Changed] The editor of the Multi-column Table tag was changed. Now when you start editing this tag,
two columns, header row, and one cell row are added automatically; self-descriptive hints are also
displayed in these cells and column headers.
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v1.0.0 (release of v1.0) | 2006-Oct-31
The first official version released.
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